# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Exp No</th>
<th>Title</th>
<th>Page No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Electrical Circuits Simulation using Multisim Electronics Workbench</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>Resistors &amp; OHM’S Law</td>
<td>12</td>
</tr>
<tr>
<td>3</td>
<td>Kirchhoff’s Law</td>
<td>18</td>
</tr>
<tr>
<td>4</td>
<td>Current and Voltage Divider Rules</td>
<td>21</td>
</tr>
<tr>
<td>5</td>
<td>Superposition Theorem</td>
<td>26</td>
</tr>
<tr>
<td>6</td>
<td>THEVENIN / NORTON Theorems and Maximum Power Transfer</td>
<td>29</td>
</tr>
<tr>
<td>7</td>
<td>The Oscilloscope and Function Generator</td>
<td>34</td>
</tr>
<tr>
<td>8</td>
<td>Frequency Domain Analysis</td>
<td>38</td>
</tr>
<tr>
<td>9</td>
<td>Maximum Power Transfer</td>
<td>43</td>
</tr>
<tr>
<td>10</td>
<td>Average and RMS Values</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>Appendix I</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>Appendix II</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>LABORATORY REGULATIONS AND SAFETY RULES</td>
<td>53</td>
</tr>
</tbody>
</table>
The EE 204: Fundamentals of Electric Circuits Lab is intended to teach the basics of Electrical Engineering to undergraduates of other engineering departments. The main aim is to provide the students with hands-on experience to enable them to put theoretical concepts into practice.

The manual starts off with the basic laws such as Ohm's Law and Kirchhoff's Current and Voltage Laws. The two experiments augment students' understanding of the relations of voltage and current and how they are implemented in practice.

Computer simulation is also stressed as it is a key analysis tool of engineering design. Multisim is used for the simulation of electric circuits and is a standard tool at numerous universities and industries in the world. The simulated parameters are then verified through actual experiment. Use of oscilloscopes is also stressed as an analysis tool. The important theorems of Thevenin and Norton are also provided along with the frequency domain analysis of circuits. They greatly simplify the complex electrical networks for analytical purposes.

By the end, students should have a thorough grasp of the concepts of electric circuits and be able to apply them further in their field of study.
Experiment No. 1
Electrical Circuits Simulation using Multisim Electronics Workbench: An Introduction

Simulation is a mathematical way of representing the actual behavior of a circuit. With simulation, you can determine a circuit’s performance without physically constructing the circuit or using actual test instruments. Multisim is a complete system design tool that offers a very large component database, schematic entry, full analog/digital SPICE simulation, etc. It also offers a single easy-to-use graphical interface for all design needs.

Introduction

Go to Start ➔ Programs ➔ Multisim and click on Multisim. This will open the main window as shown in Fig. 1. In Fig. 1 important toolbars and menu are labeled. In addition to the toolbars shown in Fig. 1, there may be other toolbars appearing on your screen so concentrate on the labeled items in Fig. 1 at this time.

You can always open and close a toolbar from the Main Menu. For example, if you want to open or close (select/unselect) the Design Toolbar, select View ➔ Toolbars ➔ Design. If any toolbar does not appear on your screen then use the above procedure to make it appear.

Most of the analysis can be performed by turning on/off the simulate switch. If the Simulation Switch shown in Fig. 1 does not appear on your screen then select View ➔ Show Simulate Switch in the Main Menu. This will open the Simulation Switch.

Figure. 1: Main Window of Multisim Simulation Software
We will now try to learn about *Multisim* simulation techniques by solving a simple example.

**Example**

Build the circuit shown in Fig. 2 using *Multisim* Electronics Workbench.

![Circuit Diagram](image)

**Figure. 2: Circuit for Multisim Simulation**

---

**STEP A: Placing the Components**

1. **Place a Battery (DC Source)**

   a. *Bring a DC source into the Multisim workspace:*

   Open the *Multisim* program if it is not already open. In the Component Toolbar, select the **Sources** icon (refer to Fig. 1 to find the Component Toolbar). This will open another window with several types of DC sources and other components as shown below in Fig. 3. Click on “DC Voltage Source” in this new window.

   ![Select DC Source](image)

   **Figure. 3: Selection of DC Voltage Source in Multisim**

   Now bring your cursor into the workspace area and notice the change in the shape of the cursor to

   ![Cursor Change](image)

   Click at any point in the workspace. This will show the voltage source as

   ![Voltage Source Displayed](image)
b. Change the value and name of the voltage source:

Double-click on the voltage source that you just placed in the workspace, and a new window with the name Battery will appear, as shown in Fig. 4. Select Value in the Battery menu, if it is not already selected. Change the value from 12 to 30. Keep the unit as Volts in this menu. Now select Label in this menu and change the Reference ID to Vs. Click on OK.

![Battery Window for setup of DC voltage source](image)

Figure 4: Battery Window for setup of DC voltage source

2. Place a Resistor:

a. Bring a resistor into the Multisim workspace:

In the Component toolbar, select the Basic icon as shown. This will open another window with several basic components as shown below in Fig. 5.

![Selection of Resistor in Multisim](image)

Figure 5: Selection of Resistor in Multisim

Click on “Resistor.” This will open the Browser-Basic window, as shown in Fig. 6. Scroll through the Component List, select 30 kOhm, and click OK. The cursor shape will change again. Click in the workspace and this will show the resistor as:

![Resistor](image)
Tip To speed up your scroll through the Browser’s **Component List**, simply type the first few characters of the component’s name. For example, type 30k to move directly to the area of the 30 kOhm list.

![Component List Diagram](image)

**Figure 6: Setup window for Resistor values**

**b. Change the name of the resistor:**

Double-click on the resistor, and a new window with the name **Resistor** will open as shown in Fig. 7. Select **Label** from the menu of this window. Change the **Reference ID** to R1 (if it is not already) and press **OK**. This will change the name of the resistor to R1.

![Label Window Diagram](image)

**Figure 7: Battery Window for Label of Resistor**
d. **Add another resistor $R_2$**

Place resistor $R_2$ of value 20 kΩ in the workspace through the same procedure.

e. **Rotate the resistor:**

Select resistor ‘$R_2$’ and press Ctrl-R to rotate the resistor or select Edit→90 Clockwise from the Main Menu. This will make the resistor vertical. Labels and values of all the components can be dragged individually. Drag the label ‘$R_2$’ and value ‘20 kOhm’ individually to put them in a suitable place.

3. **Place Ground:**

In the Component Toolbar, select the **Sources** icon. Now click on the **Ground** icon in the new window as shown in Fig. 8. Click in the workspace to show the Ground symbol as below.

![Select the Sources Icon from Component Toolbar](image)

![Select Ground](image)

Figure 8: Selection of Ground in **Multisim**

---

**STEP B: Connecting the Components**

1. **Arrange the components properly:**

Arrange the components according to the circuit given in Fig. 2. You can select and drag the component to any place in the workspace. Select the components and drag them one by one to their proper places as shown in Fig. 9.

![R1 and R2 connections](image)

Figure 9: Arranging the Components in proper order
2. **Show Grid in the workspace:**

   You may show a grid for ease of drawing the connections. Select **View ➔ Grid Visible** in the Main Menu if it is not already visible.

3. **Connect DC Voltage Source “Vs” to “R₁”:**

   Bring the cursor close to the upper pin of “Vs”; the cursor shape will change to a plus sign. Click and move a little upward. A wire appears, attached to the cursor. Click again at a small distance above the “Vs” source. Notice that the line will change direction. Control the flow of the wire by clicking on points as you drag. Each click fixes the wire to that point as shown in Fig. 10. In this way, when the cursor reaches the pin of R₁ click again and this will connect “Vs” to “R₁”. Notice that a node number is automatically given.

![Figure 10: Manual connection of components](image)

4. **Connect “R₁” to “R₂”:**

   Connect R₁ to R₂ using the same procedure.

5. **Making use of the Junction to connect the Ground:**

   In a similar manner, connect the ground with Vₘₛ and R₂. Notice that a small black circle appears just above the ground, this is called the junction. When two or more components are connected at one point, a junction is created. A junction can also be placed manually by pressing Ctrl+J or selecting **Edit ➔ Place Junction**. This can be used to control the connection points manually. Also notice that the ground node is automatically given node number 0. Do not alter it.

   This completes the connection and the complete circuit is shown in Fig. 11.

![Figure 11: Complete Circuit in Multisim](image)
6. Wire paths can be modified using drag points. Click on a wire. A number of drag points will appear on the wire as shown in Fig. 12. Click any of these and drag to modify the shape. You can also add or remove drag points to give you even more control over the wire shape. To add or remove drag points, press CTRL and click on the location where you want the drag point added or removed.

![Drag Points](image)

Figure 12: Drag points for connecting wire

---

### STEP C: Placing Multimeter or Voltmeter in parallel to measure voltage

1. **To connect a Multimeter:**
   a. Select **View → Toolbar → Instruments**. The Instruments toolbar will open as shown in Fig. 13.

![Instruments Toolbar](image)

Figure 13: Instruments Toolbar

b. Click on the **Multimeter** icon. Now click in the workspace to place the **Multimeter**. Drag it and place it near resistor R₁ as shown in Fig. 14. Make a connection from the ‘+’ terminal of the **Multimeter** to the left pin of R₁ and from the ‘−’ terminal to the right pin of R₁. Note that the reversal of + and − terminals will give opposite readings.

![Multimeter connection](image)

Figure 14: Multimeter connection for voltage measurement
c. Set the Multimeter to measure DC voltage:

Double-click on Multimeter to open the properties window shown in Fig. 15. Select ‘V’ to measure voltage. Select the DC wave shape. (Notice that the meter can also measure current ‘A’ and resistance ‘Ω’. It can measure AC as well as DC values. Leave the window open for viewing the measurements.

![Multimeter properties window](image)

Figure 15: Multimeter properties window

---

**STEP D: Placing a Multimeter or Ammeter in series to measure current**

1. Place a second Multimeter in the workspace as we did in Step C. Remove the connection between $R_1$ and $R_2$. Connect the ‘+’ terminal of the Multimeter towards $R_1$ and the ‘−’ terminal towards $R_2$ as shown in Fig. 16.

2. **Set the Multimeter to measure current:**
   Double click on this multimeter and select ‘A’ in the multimeter properties window. Set the wave shape to DC. If the current flows from 3 to zero, the meter will read positive.

![Multimeter connection for current measurement](image)

Figure 16: Multimeter connection for current measurement
Example:

<table>
<thead>
<tr>
<th>V1</th>
<th>V2</th>
<th>IT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Exercise:

<table>
<thead>
<tr>
<th>IT</th>
<th>I1</th>
<th>I2</th>
<th>V1</th>
<th>V2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Conclusion:
Objective:

1- To determine the value of a selection of resistors using three different methods:
   a. Using the color codes (to give the nominal value)
   b. Using the digital Ohmmeter.
   c. Using Ohm’s Law.

2- To determine qualitatively the effect of increased power dissipation on a carbon resistor.

Pre-Lab Assignment:

For the circuit shown in the Figure below, calculate V, and I.

![Circuit Diagram]

Apparatus:

   DC Power Supply
   Digital Multimeter
   Resistor: 100Ω, 470Ω, 1 KΩ.

Theory:

1- The basic relationship between voltage, current, and resistance is determined by Ohm’s law:

   \[ V = I \times R \]  \hspace{1cm} (1)

Where:

   \( V \) = Voltage across the resistor (in Volts)
   \( I \) = Current through the resistor (in Amperes)
   \( R \) = Resistance of the resistor (in Ohms)
2- Given any resistor, its resistance can be found by one of the three methods:

   a- Using the color codes. This value is called the nominal value, and it is only approximate.
   b- Direct measurement using an Ohmmeter.
   c- Measuring the voltage across the resistor and the current through the resistor; then applying Ohm’s law.

3- The product of the voltage across a resistor and the current through the resistor give power $P$ (Watt), namely:

\[ P = V I = I^2 R = \frac{V^2}{R} \]  \hspace{1cm} (2)

where equation (1) has been used to express $P$ in terms of $I^2$ and in terms of $V^2$.

The power absorbed by the resistor appears in the form of heat. The physical size of the resistor determines the amount of power that it can safely dissipate. This amount is referred to as the power rating. The dissipation of power that exceeds the power rating can damage the resistor physically.

When the resistor gets heated due to excessive power dissipation, its resistance changes. It will either increase or decrease depending on the temperature coefficient. A carbon resistance is expected to increase as the temperature increases.

Resistances that are operated above the power rating will deviate from the straight line relationship between $V$ and $I$. The resistor in this case is operating in the non-linear region. In such case, the resistance is no longer equal to the slope of the $V$ versus $I$ graphs. It may however, be calculated using the ratio $V/I$.

**Procedure:**

You will be supplied with sets of 5 resistors.

1. Find the nominal value and the tolerance of each resistance using the Resistor colour code chart shown below. Note the relation between the power rating and the physical size of the resistance.
2. Using the digital multimeter as an ohmmeter, measure and record the resistance of each resistor.
3. Connect the circuit as shown in Figure 2 for $R = 100 \, \Omega$ and perform the following:
   a- Set the source voltage $V_s$ to 10 V.
   b- Measure $V$ and $I$.
   c- Repeat steps 3a and 3b for the remaining resistors.
   d- Record your results in Table 1.
4. Using a 1 W resistor (R = 470Ω), vary the input voltage from 6 to 20 volts. Measure \( V \) and \( I \) and calculate the resistance \( R \) (by calculating the ratio \( V/I \)) and the power dissipated in the resistance (by calculating the product \( VI \)). As the measurement proceeds, touch the resistor from time to time to observe the temperature rise. Record the results in Table 2.
Questions:

1. Plot $P$ versus $R$ in Fig. 3.

![Figure 3: $P$ versus $R$](image)

Comment on the linearity of $R$ as $P$ increases.

2. Does the resistor in step 4 operate in the linear region or non-linear region? Explain by considering the power rating of the resistor.

3. An electric heater takes 1.48 kW from a voltage source of 220 V. Find the resistance of the heater.

4. If the current in a resistor doubles, what happens to the dissipated power? (Assume the resistor operates in the linear region).

5. A 4 $\Omega$ resistor has to be used in a circuit where the voltage across the resistor is 3V. If two 4 $\Omega$ resistors with 2 W and 3 W power ratings are available, which will you use and why?
### Table 1. Resistor values:

<table>
<thead>
<tr>
<th>Resistor</th>
<th>R1</th>
<th>R2</th>
<th>R3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal value / Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ohmmeter reading</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>V / I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Deviation from nominal value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual value within tolerance?</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 2. Power Rating: (R = 470Ω, 1W)

<table>
<thead>
<tr>
<th>V (volt)</th>
<th>6</th>
<th>10</th>
<th>15</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td>I (mA)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R (Ohm) = V/I</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P (Watt)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table. 1: Resistor Values

<table>
<thead>
<tr>
<th>Resistor</th>
<th>R1</th>
<th>R2</th>
<th>R3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal value / Tolerance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ohmmeter reading</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>V / I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Deviation from nominal value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual value within tolerance?</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table. 2: Power Rating

Figure. 3:  $R$ versus $P$

Answer to Questions:

1.
2.
3.
4.
Experiment No. 3

Kirchhoff’s Law

Objective:
To verify Kirchhoff’s Voltage and Current Law experimentally.

Pre-Lab Assignment:
For the circuit shown in Figure 1, calculate:
1- V_{AB}, V_{BC}, V_{AD}, V_{DC}, V_{BD}, and V_{AC}.
2- I_1, I_2, I_3, I_4 and I_5.

Apparatus:
DC Power Supply
Digital Multimeter
Carbon Resistors: 100Ω, 150Ω, 220Ω, and 330Ω

Theory:
• Kirchhoff’s Voltage Law (KVL):
The algebraic sum of all voltages around any closed path is equal to zero.

• Kirchhoff’s Current Law (KCL):
The algebraic sum of all currents at a junction point is equal to zero.

Procedure:
1- Check the values of the resistors, used in the circuit of Figure 1, using a multimeter. Record the values in Table 1.
2- Connect the circuit as shown, and have it checked by the instructor. Adjust the supply voltage V_s to 10 V, using a DC voltmeter (DMM).
3- Measure the voltages V_{AB}, V_{BC}, V_{AD}, V_{DC}, V_{BD}, and V_{AC}. Record their values (including the signs) in Table 2.
4- Measure the currents I_1, I_2, I_3, I_4 and I_5 and record their values (including the signs) in Table 3.
Report:

1- Verify KVL by adding the experimental values of voltages around the loops:
   a) ABCEFA
   b) CDAC

2- Verify KCL by adding the experimental values of currents at nodes:
   a) A
   b) B
   c) C

Questions:

1- Do the experimental and theoretical values of voltages and currents agree? Indicate the percentage of differences.
2- Give possible reasons for any discrepancies.
Table 1 Resistor Values:

<table>
<thead>
<tr>
<th>Resistor</th>
<th>R1</th>
<th>R2</th>
<th>R3</th>
<th>R4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal value (Ohm)</td>
<td>100</td>
<td>150</td>
<td>220</td>
<td>330</td>
</tr>
<tr>
<td>Ohmmeter reading</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 2 Voltages:

<table>
<thead>
<tr>
<th>Voltage</th>
<th>( V_{AB} )</th>
<th>( V_{BC} )</th>
<th>( V_{AD} )</th>
<th>( V_{DC} )</th>
<th>( V_{BD} )</th>
<th>( V_{AC} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Experiment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3: Currents:

<table>
<thead>
<tr>
<th>Current</th>
<th>( I_1 )</th>
<th>( I_2 )</th>
<th>( I_3 )</th>
<th>( I_4 )</th>
<th>( I_5 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Experiment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Report:

1. 

2. 

Answers to Questions:

1. 

2. 
Objective:

To experimentally verify the **Current Divider Rule (CDR)** for parallel circuits and the **Voltage Divider Rule (VDR)** for series circuits.

Pre-Lab Assignment:

For the circuit shown in Figure 1 and Figure 2, calculate:

1. The unknown voltages and currents shown. $V_s=10V$.
2. The equivalent resistance seen by $V_s$.

Hint: Read through this experiment.

Apparatus:  
- DC Power Supply
- Digital Multimeter
- Carbon Resistors: 100Ω, 150Ω, 220Ω and 330Ω.

Objectives:

1. To study the voltage current relationships of series and parallel circuits
2. To verify the voltage current divider and voltage divider rules.

Introduction:

![Series circuit](image1.png)  

![Parallel circuit](image2.png)

Figure. 1: Series circuit  

Figure. 2: Parallel circuit
For a series circuit shown in Fig. 1, the voltages across resistors $R_1$, $R_2$ and $R_3$ can be written as:

\[
V_1 = \frac{R_1}{R_1 + R_2 + R_3} V_s \\
V_2 = \frac{R_2}{R_1 + R_2 + R_3} V_s \\
V_3 = \frac{R_3}{R_1 + R_2 + R_3} V_s
\]  

(1)

This is the **Voltage Divider Rule (VDR)**.

For a parallel circuit given in Fig. 2, the branch currents can be written in terms of the total current as:

\[
I_1 = \frac{R_2}{R_1 + R_2} I_s \\
I_2 = \frac{R_1}{R_1 + R_2} I_s
\]  

(2)

This is known as the **Current Divider Rule (CDR)**.

![Series-parallel circuit I](image1)

![Series-parallel circuit II](image2)

**Figure. 3: Series-parallel circuit I**  
**Figure. 4: Series-parallel circuit II**

$V_S = 10\text{V}, R_2 = 100\Omega, R_3 = 150\Omega, R_4 = 220\Omega, R_6 = 330\Omega$
Procedure:

**Simulation**

1. Build the circuit given in Fig. 3 on Multisim Electronics Workbench.
2. Connect voltmeters, ammeters (or multimeters) at appropriate positions to measure the voltages and currents shown in Table 1.
3. Disconnect the voltage source. Connect a multimeter, measure the total resistance and record the value in Table 1. (Remember: resistance is always measured without any source connected to the circuit.)
4. Repeat steps 2 and 3 for the circuit given in Fig. 4 and record the values in Table 2.

**Hardware Experiment**

5. Build the circuit of Fig. 3 with the hardwired components. Take the voltage current measurements and $R_{eq}$ and record them in Table 1. Considering the Workbench results as the base, compute the percentage errors.
6. Build the circuit of Fig. 4 with the hardwired components. Take the voltage current measurements and $R_{eq}$ and record them in Table 2. Considering the Workbench results as the base, compute the percentage errors.

Check the values of resistors used in the circuit of Figure 2, using the Multimeter. Record the values in Table 1.

![Series-parallel circuit I](image1)

![Series-parallel circuit II](image2)

Figure. 3: Series-parallel circuit I  
Figure. 4: Series-parallel circuit II

$R_2 = 100\Omega$, $R_3 = 220\Omega$, $R_4 = 150\Omega$, $R_6 = 330\Omega$
7. Connect the circuit of Figure 2a and adjust the supply voltage $V_s$ to 10 V, using the DC voltmeter.
8. Measure all the unknown voltages and currents shown. Record their values in Table 2.
9. Measure $R_{eq}$ using an Ohmmeter and record its values in Table 2.
10. Connect the circuit of Figure 2b and adjust the supply voltage $V_s$ to 10 V, using the DC voltmeter.
11. Measure all the unknown voltages and currents shown. Record their values in Table 3. (Recall that when measuring current with an ammeter, the ammeter should be placed in series with the element in which the current passes. Keep this fact in mind when measuring $I_5$)
12. Measure $R_{eq}$ and record its value in Table 3.

Questions

1. Give reasons for any discrepancies between the theoretical and experimental values of voltages and currents and the equivalent resistance of both circuits.

By referring to the circuit of Figure 3:
2. Are $R_4$ and $R_6$ in parallel or in series?
3. Are $R_3$ and $R_4$ in parallel or in series?
4. Are $V_s$ and $R_6$ in series or in parallel?
5. Is VDR applicable for $R_3$ and $R_4$?
6. Is CDR applicable for $R_4$ and $R_6$?
7. Is the parallel combination of $R_4$ and $R_6$ in series or in parallel with $R_2$?

**TABLE 1**

<table>
<thead>
<tr>
<th>Resistor</th>
<th>R2</th>
<th>R3</th>
<th>R4</th>
<th>R6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Value (Ohm)</td>
<td>100</td>
<td>220</td>
<td>150</td>
<td>330</td>
</tr>
<tr>
<td>Ohmmeter reading</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**TABLE 2**

<table>
<thead>
<tr>
<th>Unknown</th>
<th>$I_1$</th>
<th>$I_2$</th>
<th>$I_3$</th>
<th>$I_4$</th>
<th>$I_5$</th>
<th>$I_6$</th>
<th>$V_2$</th>
<th>$V_3$</th>
<th>$V_4$</th>
<th>$V_5$</th>
<th>$V_6$</th>
<th>$R_{eq}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Experiment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**TABLE 3**

<table>
<thead>
<tr>
<th>Unknown</th>
<th>$I_1$</th>
<th>$I_2$</th>
<th>$I_3$</th>
<th>$I_4$</th>
<th>$I_5$</th>
<th>$I_6$</th>
<th>$V_2$</th>
<th>$V_3$</th>
<th>$V_4$</th>
<th>$V_5$</th>
<th>$V_6$</th>
<th>$R_{eq}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Experiment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME</td>
<td>______________________</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEC #</td>
<td>__________</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID #</td>
<td>______________________</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SERIAL#</td>
<td>__________</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Answers to Questions:**

1. 

2. 

3. 

4. 

5. 

6. 

7. 
Objective:
The objective of this experiment is to verify the superposition theorem experimentally and using simulation.

Pre-Lab Assignment:
For the circuit shown in Figure 1:
1. Find the $V_1$ & $I_1$ superposition.
2. Record your values in Table 2 and 3.

Note:
- $V_1$, $I_1$ are due to 5 V source
- $V_2$, $I_2$ are due to 10 V source
- $V_3$ & $I_3$ are due to both sources

Apparatus: DC Power Supply (Two)
Digital Multimeter.
Carbon Resistors: 10 kΩ, 22 kΩ, 33 kΩ, 47 kΩ, and 1 kΩ.
PC for simulation with *multisim*

Introduction
The voltage and current responses in a network from two or more sources acting simultaneously can be obtained as the sum of the responses from each source acting alone with other sources deactivated. A deactivated current source is an open circuit. A deactivated voltage source is a short circuit.

Procedure:

*Note: do all the steps using computer simulation and experimentally.*

**Step 1 is experimental only.**
1. Check the values of the resistors using the multimeter. Record the values in Table.1.
2. Connect the circuit of Figure.1 and measure $V_1$ & $I_1$
3. Deactivate the 10 V source and measure $V_2$ & $I_2$
4. Reactivate the 10 V sources and deactivate the 5 V source. Measure $V_2'$, and $I_2'$
5. Record the results in Tables 2 and 3
Figure 1

Questions:

1. Discuss the reasons for any discrepancies between the theoretical and experimental values for all cases.

2. Does computer simulation represent actual circuit behavior? Discuss your answer by referring to your results.
NAME ______________________  SEC #  __________
ID # ______________________  SERIAL# __________

TABLE 1
Resistor Values:

<table>
<thead>
<tr>
<th>Resistor</th>
<th>R1</th>
<th>R2</th>
<th>R3</th>
<th>R4</th>
<th>R5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal value (Ohm)</td>
<td>10KΩ</td>
<td>22KΩ</td>
<td>1KΩ</td>
<td>47KΩ</td>
<td>33KΩ</td>
</tr>
<tr>
<td>Ohmmeter Reading</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TABLE 2
Superposition Theorem:

<table>
<thead>
<tr>
<th></th>
<th>$V_1$ (V)</th>
<th>$V_2$ (V)</th>
<th>$V_3$ (V)</th>
<th>$I_1$ (mA)</th>
<th>$I_2$ (mA)</th>
<th>$I_3$ (mA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simulation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TABLE 3

<table>
<thead>
<tr>
<th></th>
<th>$V_1$ (V)</th>
<th>$V_2$ (V)</th>
<th>$V_3$ (V)</th>
<th>$I_1$ (mA)</th>
<th>$I_2$ (mA)</th>
<th>$I_3$ (mA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Experiment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Answers to Questions:

1.

2.
Experiment No. 6
THEVENIN / NORTON Theorems and Maximum Power Transfer

Objective:

1- To experimentally verify the Thevenin and Norton Theorems.
2- To experimentally verify the Maximum Power Transfer Theorem for resistive circuits.

Pre-Lab Assignment:

For the circuit shown in Figure 1:

1- Find the $V_{TH}$, $I_{SC}$ and $R_{th}$ seen by $R_L$.
2- Use the Thevenin equivalent circuit you obtained to find the values of $V_L$ when $R_L$ is varied from 2.5 K to 10.5 K in steps of 1 K Ohms. Calculate $V_L$ in each case.
3- Calculate the power $P_L$ absorbed by $R_L$ in each case of step 2.
4- Find the value of $R_L$ for Maximum Power Transfer and the value of the Maximum Power.

Summarize your results in Tables 2, 3 and 4.

Apparatus:

- DC Power Supply (Two)
- Digital Multimeter.
- Carbon Resistors: 10 kΩ, 22 kΩ, 33 kΩ, 47 kΩ, and 1 kΩ.
- Decade Resistor Box.

Theory:

- **Thevenin’s Theorem:**

  A two-terminal network can be replaced by a voltage source with the value equal to the open circuit voltage across its terminals, in series with a resistor with the value equal to the equivalent resistance of the network.

- **Norton’s Theorem:**

  A two-terminal network can be replaced by a current source with the value equal to the short circuit current at its terminal, in parallel with a resistor with the value equal to the equivalent resistance of the network. The equivalent resistance of a two-terminal network is equal to the open circuit voltage divided by the short circuit current.
• Maximum Power Transfer Theorem:

In a resistive circuit, a resistive load receives maximum power when the load resistance is equal to Thevenin’s equivalent resistance of the circuit (i.e. $R_L = R_{TH}$). The maximum power can be calculated using the expression:

$$p = \frac{V_{OC}^2}{4R_{TH}}$$

where $V_{TH}$ is the open circuit voltage.

Procedure:

Connect the circuit as shown in figure 1.

1. Check the values of the resistors using the multimeter. Record the values in Table 1.
2. Remove $R_L$ from the original circuit and measure the open circuit voltage $V_{oc}$ (or $V_{TH}$).
3. Measure the short circuit current $I_{sc}$. This is accomplished by placing an ammeter between A and B. In this manner, the ammeter will act as a short circuit.
4. Replace the voltage sources with short circuits. With $R_L$ removed from the circuit, measure $R_{th}$ using a multimeter.
5. Record the results in Table 2.
Maximum Power Transfer:

6. Reconnect the circuit as shown in Figure 1, but replace the 22 KΩ resistor between A and B with a variable resistor (i.e. \( R_L \) in this case is the variable resistor).
7. Vary \( R_L \) from 2.5 KΩ to 10.5 KΩ in steps of 1 KΩ and measure \( V_L \) in each case.
8. Record the results in Table 3.
9. Calculate \( P_L \) from Step. 7 above and record the results in Table 4.

Questions:

1. Draw Thevenin’s and Norton’s equivalent circuit obtained experimentally.
2. Plot the theoretical and experimental values of \( P_L \) versus \( R_L \) (on the same graph) and compare the two graphs.
3. Discuss the reasons for any discrepancies between the theoretical and experimental values for all cases.
4. Thevenin’s and Norton’s theorems are very useful. List at least two reasons why.
| TABLE 1 |
|---------------------|-----|-----|-----|-----|-----|
| Resistor           | R1  | R2  | R3  | R4  | R5  |
| Nominal value (Ohm)| 10K | 22K | 1K  | 47K | 33K |
| Ohmmeter Reading   |     |     |     |     |     |

| TABLE 2 |
|-------------------|-------|-------|-------|
|                   | $V_{TH}$ (V) | $I_{sc}$ (mA) | $R_{TH}$ (K Ohm) |
| Theory            |         |         |        |
| Experiment        |         |         |        |
| Error             |         |         |        |

| TABLE 3 |
|--------------------------|-----|-----|-----|-----|-----|-----|-----|-----|-----|
| $R_L$ (K Ohm)            | 2.5 | 3.5 | 4.5 | 5.5 | 6.5 | 7.5 | 8.5 | 9.5 | 10.5 |
| $V_L$ (Theoretical)      |     |     |     |     |     |     |     |     |     |
| $V_L$ (Experimental)     |     |     |     |     |     |     |     |     |     |

| TABLE 4 |
|---------------------|-----|-----|-----|-----|-----|-----|-----|-----|-----|
| $R_L$ (K Ohm)       | 2.5 | 3.5 | 4.5 | 5.5 | 6.5 | 7.5 | 8.5 | 9.5 | 10.5 |
| $P_L$ (Theoretical) |     |     |     |     |     |     |     |     |     |
| $P_L$ (Experimental)|     |     |     |     |     |     |     |     |     |
| % Error             |     |     |     |     |     |     |     |     |     |
### Answers to Questions:

<table>
<thead>
<tr>
<th>Thevenin’s Equivalent Circuit</th>
<th>Norton’s Equivalent Circuit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td></td>
</tr>
</tbody>
</table>

![Diagram](image_url)

2. 

3. 

4. 

5.
Experiment No. 7
The Oscilloscope and Function Generator

**Introduction**

The **oscilloscope** is one of the most important electronic instruments available for making circuit measurements. It displays a curve plot of time-varying voltage on the **oscilloscope** screen.

The controls on the **oscilloscope** are as follows:

1. The TIME/DIV control adjusts the time scale on the horizontal axis in time per division. The X_POS control determines the horizontal position where the curve plot begins.
2. The CHANNEL A control adjusts the volts per division on the vertical axis for the CHANNEL A curve plot. The POSITION control located on top of CHANNEL A determines the vertical position of the CHANNEL A curve plot relative to the horizontal axis. Selecting AC places a capacitance between the CHANNEL A vertical input and the circuit testing point. Selecting “GROUND” connects CHANNEL A vertical input to ground.
3. The same thing applies to CHANNEL B.

**The Function Generator**

The **Function Generator** is a voltage source that supplies different time-varying voltage functions. The **Function Generator** can supply **Sine Wave**, **Square Wave**, and **Triangular Wave** voltage functions. The waveshape, frequency, amplitude, and DC offset can be easily changed.

The controls on the **Function Generator** are as follows:

1. You can select a waveshape by selecting the appropriate waveshape (**Sine wave**, **Square Wave** and **Triangular Wave**) on the top of the **Function Generator**.
2. The frequency control allows you adjust the frequency of the output voltage. Select the frequency button and select the frequency with the appropriate scale.
3. The AMPLITUDE buttons allow you to adjust the peak-to-peak value or RMS of the output voltage. The peak-to-peak value is twice the amplitude setting.
4. The OFFSET buttons adjust the DC level of the voltage curve generated by the **Function Generator**. When selecting the DC option on the Oscilloscope, an offset of 0 positions the curve plot along the x-axis with an equal positive and negative voltage setting. A positive offset raises the curve plot above the x-axis and a negative offset lowers the curve plot below the x-axis.
**Procedure**

1. Connect the output of the Function Generator to CHANNEL A on the oscilloscope.
2. Turn the Function Generator and select the *Sine Wave* button. Set frequency to 1 kHz and 2 Vp-p. Set the DC offset to 0 V DC.

3. Turn on the oscilloscope and select the GROUND button. Using the POSITION control on the top, bring your line to the center of the screen. Now select the AC position.

4. Select the TIME/DIV to 0.2ms and CHANNEL A to 0.5 V/DIV.  
   **Question:** What was the time period (T) and the frequency of your signal?

5. Select the “GROUND” on the oscilloscope channel A.  
   **Question:** What change occurred on the oscilloscope Channel A curve plot? Explain.

6. Change the oscilloscope channel A to 1V/div.  
   **Question:** What change occurred on the oscilloscope Channel A curve plot? Explain.

7. Change the oscilloscope Time Base to 0.1ms/div.  
   **Question:** What change occurred on the oscilloscope Channel A curve plot? What is the period and the frequency of your signal? Compare the results to that of step 4.

8. Return the oscilloscope time base to 0.2m/DIV and CHANNEL A to 0.5V/DIV. Select the *Triangular Wave* shape on the Function Generator.  
   **Question:** What change occurred on the oscilloscope curve plot?

9. Select the *Square Wave* on the Function Generator and run the analysis again.  
   **Question:** What change occurred on the oscilloscope curve plot?

10. Change the AMPLITUDE on the Function Generator to 2Vp-p  
    **Question:** What change occurred on the oscilloscope curve plot? Explain.

11. Change the frequency on the Function Generator to 2 kHz.  
    **Question:** What change occurred on the oscilloscope curve plot? Explain.

12. Change the offset on the Function Generator to 1V.  
    **Question:** What change occurred on the oscilloscope curve plot? Explain.

13. Select the DC setting on CHANNEL A of the oscilloscope.  
    **Question:** What change occurred on the oscilloscope curve plot? Explain.
Answers to Questions in Procedures

Question of Step 4

Question of Step 5

Question of Step 6

Question of Step 7

Question of Step 8

Question of Step 9
Question of Step 10

Question of Step 11

Question of Step 12

Question of Step 13

Question of Step 13
Objective:

1. To experimentally verify frequency domain calculations using the phasor method.
2. To experimentally measure the phase difference between two sinusoidal signals.

Pre-Lab Assignment:

For the circuit shown in Figure 2:

1- Assume that the inductor has an internal resistance of 4 Ohms.
2- Add 1.5 KΩ resistor with the inductor.
3- Let the source voltage $V_s$ have a peak amplitude of 5 V and frequency $f = 20$ kHz. Assume that $V_s$ has a zero phase angle.
4- Use the phasor method to calculate all voltages and currents shown.

Record your results in Table 2.

Apparatus:

Signal Generator.
Digital Multimeter.
Oscilloscope.
Capacitor 0.022 µF.
Inductor 10 mH
Resistor: 1.5 KΩ.

Theory:

In the frequency domain (phasor domain), the currents and voltages are represented by complex numbers whose magnitudes are equal to the maximum values of the sinusoidal time-domain quantities, and whose angles are equal to the phase angles of the time-domain functions expressed as cosines.

In terms of voltage and current phasors and the complex impedance $\bar{Z}$, Ohm’s law becomes:

$$\bar{V} = \bar{I} \bar{Z}$$  \hspace{1cm} (1)

Where

$$\bar{Z} = R \quad \text{for a resistance}$$
$$= j\omega L \quad \text{for an inductance}$$
$$= \frac{1}{j\omega C} \quad \text{for a capacitance}$$

where $\omega = 2\pi f$ is the angular frequency of the source. The bar indicates a complex quantity.
In general, for $V = V_1 \angle \theta_1$ and $I = I_2 \angle \theta_2$, the impedance $Z = \frac{V}{I} \angle \theta_1 - \theta_2$.

Analytically, frequency-domain circuits are treated in the same method as used in DC circuits, except that the algebra of complex numbers is used.

Experimentally, the frequency-domain phasors can be measured on the oscilloscope. The magnitudes can be measured by means of calibrated vertical scales. Phase difference can be measured by using the dual traces and measuring the time difference between two waveforms, as illustrated in Figure 2.

**IMPORTANT NOTE:**

When measuring the phase difference between two signals, make sure that the control knobs in the oscilloscope are set properly such that the signals are not relatively inverted.

![Diagram showing phase shift and time shift](image)

Figure 1

- Time shift = $\tau$
- Phase shift = $360 \left( \frac{\tau}{T} \right)$ degrees
- Signal B lags signal A.
Procedure:

1. Measure the resistor value and the internal resistance of the inductor, using an ohmmeter.
2. Connect the circuit of Figure 2. Adjust the source voltage to 5 V peak at 20 kHz, while it is connected to the circuit.
3. Use the oscilloscope to measure the magnitudes and phases of all voltages and record the values in Table 2.
4. Find the value of the current using the following equation:

   \[ I = \frac{V_s}{R} \]

Important Note:

1. When measuring the phase difference between two signals, make sure that the control knobs of the oscilloscope are set properly such that the signals are not relatively inverted.
2. Whenever two signals are to be displayed simultaneously on the oscilloscope, they should have one common node as a reference. Therefore, you may have to change the position of some elements to be able to measure two signals simultaneously.
3. To find \( I_2 \), measure the voltage on the 1.5KΩ resistor.

Report:

1. Draw the circuit of Figure 2 in the frequency domain (in the phasor representation). Use the space available in the report sheet at the end of the experiment.
2. Record the theoretical and experimental values in Table 2.
3. Draw the phasor diagram, showing all the voltages and currents, based on the experimental values. Use the space available in the report sheet at the end of the experiment.
4. Discuss the sources of discrepancies between the theoretical and experimental values.
Questions:

1. For a resistance and capacitance in series with a voltage source, show that it is possible to draw a phasor diagram for the current and all voltages from magnitude measurement of these quantities only. Illustrate your answer graphically.

2. The equivalent impedance of a capacitor in series with an inductor is equivalent to a short circuit (i.e. equal to zero) at a certain frequency. Derive an expression for this frequency.

3. The equivalent impedance of a capacitor in parallel with an inductor is equivalent to an open circuit (i.e. equal to infinity) at a certain frequency. Derive an expression for this frequency.
TABLE 1

<table>
<thead>
<tr>
<th>Resistor</th>
<th>$R_1$</th>
<th>Internal resistance of Inductor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Value ( Ohm )</td>
<td>1.5KΩ</td>
<td></td>
</tr>
<tr>
<td>Ohmmeter Reading</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Internal resistance of the inductor = $\Omega$

TABLE 2

<table>
<thead>
<tr>
<th></th>
<th>$V_R$</th>
<th>$V_L$</th>
<th>$V_C$</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theoretical Values</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnitude ( Volts )</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase Shift ( Degree )</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Experimental Values</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnitude ( Volts )</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase Shift ( degrees )</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnitude (Volts)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase Shift ( degrees )</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CIRCUIT IN FREQUENCY DOMAIN

PHASOR DIAGRAM
Objective:

1. To obtain maximum output power from a sinusoidal source with an internal impedance.
2. To experimentally verify the theory of maximum power transfer.

Pre-Lab Assignment:

For the circuit shown Figure 1:

1. Assume that the inductor has an internal resistance of 4 ohms; account for this resistance in this calculation.
2. Find the value of $R_L$ and $C_L$ for maximum power transfer, and:
3. Calculate the maximum power transferred to this load.
4. Summarize your results in Table 4.

Apparatus:

- Signal Generator
- Digital Multimeter
- Decade Resistance Boxes RDB and RDA
- Decade Capacitance Box CDA
- Inductor (10 mH)
- Resistance (100 Ohms)
Theory:
Consider Figure 1. If the source impedance has resistive and reactive parts, the maximum power is transferred to the load (actually to the resistive part of the load) when the load resistance equals the source resistance and the load reactance is opposite to the source reactance. Namely

\[ Z_L = Z_S^* \]  \hspace{2cm} (1)

Equation (1) implies that if the source impedance is inductive the load impedance must be capacitive and vice versa. In order to compute the value of a capacitance, one can use the following relation

\[ \omega = 1/\sqrt{LC} \]
\[ C = 1/\omega^2 L \]  \hspace{2cm} (2)

Note that since \( Z_L = Z_S \), \( V_S \) sees a combined load with impedance \( Z_L + Z_S = Z_S + Z_S = 2R_S \) which is purely resistive. This means, under this condition (the condition of maximum power transfer), \( V_S \) becomes in phase with the current through the load and thus \( V_S \) becomes in phase with the voltage across the load resistance.

The maximum power transferred to the load in this is

\[ P_{\text{max}} = \frac{V_s^2}{4R_s} \]  \hspace{2cm} (3)

Procedure:
1. Consider the 10 mH inductor in the circuit of Fig. 1 as part of the source impedance. Measure its internal resistance \( R_i \), then add 100 Ohm in addition to this resistance. This means \( R_S = R_i + 100 \). Set the source voltage to a sinusoid of 1 V\(_{\text{RMS}}\) and frequency of 15 KHz.
2. With \( R_L \) set at the value of \( R_S \), vary \( C \) from 0.007 \( \mu F \) to 0.015 \( \mu F \) in steps of 0.001 \( \mu F \) (use two decade capacitors in parallel). Measure the voltage across \( R_L \) in each case, maintaining an input voltage of 1 V\(_{\text{RMS}}\). Record the values in table 2.
3. Display the source voltage and the voltage across \( R_L \) simultaneously on the oscilloscope. Vary \( C \) and notice the phase shift between the two signals. Record the value of \( C \) that makes the two signals in phase.

4. With \( C \) set at the value found in step 3, vary \( R_L \) from 80-120 and measure the voltage across \( R_L \) in each case, again maintaining an input voltage of 1 V\text{RMS}. Record the values in table 4.

**Note:** Record your results in Table No. 1, 2, 3 & 4 and answer the questions:

**Questions:**

1) What is the phase difference between the current and the voltage source when maximum power transfer is achieved?

2) If the frequency of the source is doubled, what change should be made to maintain maximum power transfer to the load? How does this change affect the value of the maximum power? Explain.

3) Comment on the causes of errors between the measured and calculated values.
**Table 1. Resistive value**

<table>
<thead>
<tr>
<th>Resistor</th>
<th>R1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Value (Ohm)</td>
<td>4</td>
</tr>
<tr>
<td>Ohmmeter Reading</td>
<td></td>
</tr>
</tbody>
</table>

Internal Resistance of the inductance $R_i =$

**Table 2. Results for $C$**

<table>
<thead>
<tr>
<th>$C$ (µF)</th>
<th>0.007</th>
<th>0.008</th>
<th>0.009</th>
<th>0.010</th>
<th>0.011</th>
<th>0.012</th>
<th>0.013</th>
<th>0.0147</th>
<th>0.0153</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_L$ (V)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$P_L$ (W)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 3. Results for $R_L$**

<table>
<thead>
<tr>
<th>$R_L$ (Ohm)</th>
<th>80</th>
<th>90</th>
<th>95</th>
<th>100</th>
<th>$R_s$</th>
<th>110</th>
<th>120</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_L$ (V)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$P_L$ (W)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 4. Comparison at Maximum Power Transfer**

| | | | $P_{max}$ |
|---|---|---|
| Theory | | |
| Experiment | | |
| % Error | | |
Objective:

1- To measure the average and **Root Mean Square** (RMS) values of some electrical signals.
2- To compare the calculated and experimental values.

**Pre-Lab Assignment:**

1- For the periodic signals shown in Figure 1, find:
   
a) The average value of each signal.
   b) The RMS value of each signal.

2- For the periodic signals shown in Figure 2, find the average value of each signal.

**Apparatus:**

- Oscilloscope
- Signal Generator
- Digital Multimeter (DMM)

**Theory:**

**1- Average Value:**

The average value of a periodic signal $f(t)$ is defined as:

$$f_{avg} = \frac{1}{T} \int_{0}^{T} f(t) dt = \frac{\text{area under one period}}{\text{period}}$$  \hspace{1cm} (1)

**2- The Root Mean Square value:**

The RMS value of a periodic signal $f(t)$ is defined as:

$$f_{rms} = \sqrt{\frac{1}{T} \int_{0}^{T} f^2(t) dt} = \text{Square root of the average of } f^2(t).$$  \hspace{1cm} (2)
For a general sinusoidal signal \( f(t) = A \cos(\omega t + \phi) \), it is easy to show that

\[
 f_{\text{avg}} = 0 \quad \quad (3)
\]

\[
 f_{\text{max}} = \frac{A}{\sqrt{2}} \quad \quad (4)
\]

For a signal that consists of DC and AC parts such as, \( f(t) = B + A \cos(\omega t + \phi) \)
where \( B = \) constant, it is equally easy to show that the average value is equal to the DC part only, namely:

\[
 f_{\text{avg}} = B \quad \quad (5)
\]

**Procedure:**

1- Set the oscilloscope controls as follows:

   Time / Div.   0.1 ms  Volts / Div.   0.5 V

   Vertical Display  A Coupling D.C.

2- Connect the output of the signal generator to channel A of the oscilloscope.

3- Set the signal generator to a sinusoid of 2000 Hz and a peak to peak voltage \( V_{\text{p-p}} = 2 \text{ V} \).

4- Set the DC offset of the signal generator to zero, so that the signal you obtain on the oscilloscope has no DC value as shown in figure 1.

5- Measure:

   (a) The average value of the signal with a DMM (set the voltmeter to D.C.).
   (b) The RMS value of the signal with a DMM (set the voltmeter to AC).
   (c) The period of the signal from the oscilloscope. Then calculate the corresponding frequency from the relation \( f = \frac{1}{T} \).

6- Repeat steps 3-5 for a square signal with the same \( V_{\text{p-p}} \) and frequency.

7- Repeat steps 3-5 for a triangular signal with the same \( V_{\text{p-p}} \) and frequency.

8- Set the DC offset of the signal generator to 1 V so that the signal you obtain on the oscilloscope has no DC value of 1 V as shown in figure 1.

9- Repeat the measurement of the average value for the same signals as in previous steps with the following changes:

   (a) Adjust the ground level to the bottom of the screen.
   (b) Adjust the D.C. offset of the signal generator, so that the signals start from zero and reach a peak value of 1 V as shown in Figure 2.
Note: Record your results in Table No. 1 & 2 and answer the questions.

Questions:

1- The frequency of the voltage in your house is 60 Hz. How much time is required for the waveform to complete three cycles?

2- What is the difference between AC and DC coupling of the oscilloscope? Explain how to use them to measure the average value of any periodic signal.

3- Some meters are calibrated to read RMS values of sinusoidal waveforms from the basic unit that responds to the peak value of the waveform. In terms of the peak value, \( V_p \), the meter will read \( \frac{V_p}{\sqrt{2}} \), which is the correct RMS value for a sinusoidal signal. Can this meter be used to read the correct RMS value for other waveforms like square, triangular, etc? Explain.
<table>
<thead>
<tr>
<th>TABLE 1</th>
<th>Sinusoidal</th>
<th>Square</th>
<th>Triangular</th>
</tr>
</thead>
<tbody>
<tr>
<td>T (ms)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>f (Hz)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Value (Calculated)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Value (Experimental)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RMS Value (Calculated)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RMS Value (Experimental)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TABLE 2</th>
<th>Sinusoidal</th>
<th>Square</th>
<th>Triangular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Value (Calculated)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average value (Experimental)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Error</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Answers to Questions:**

1. 

2. 

3. 
### Appendix I

#### 4 COLOR BAND RESISTOR

![Diagram of a 4 color band resistor]

#### 5 COLOR BAND RESISTOR

![Diagram of a 5 color band resistor]

<table>
<thead>
<tr>
<th>Color</th>
<th>1st Ring</th>
<th>2nd Ring</th>
<th>3rd Ring</th>
<th>4th Ring (Multiplier)</th>
<th>5th Ring (Tolerance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1 %</td>
</tr>
<tr>
<td>Brown</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>10</td>
<td>1 %</td>
</tr>
<tr>
<td>Red</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>100</td>
<td>1 %</td>
</tr>
<tr>
<td>Orange</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>1000</td>
<td>1 %</td>
</tr>
<tr>
<td>Yellow</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>10000</td>
<td>1 %</td>
</tr>
<tr>
<td>Green</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>100000</td>
<td>1 %</td>
</tr>
<tr>
<td>Blue</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>1000000</td>
<td>1 %</td>
</tr>
<tr>
<td>Violet</td>
<td>7</td>
<td>7</td>
<td>7</td>
<td>10000000</td>
<td>1 %</td>
</tr>
<tr>
<td>Gray</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>100000000</td>
<td>1 %</td>
</tr>
<tr>
<td>White</td>
<td>9</td>
<td>9</td>
<td>9</td>
<td>1000000000</td>
<td>1 %</td>
</tr>
<tr>
<td>Gold</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>5 %</td>
</tr>
<tr>
<td>Silver</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>10 %</td>
</tr>
<tr>
<td>No Color</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>20%</td>
</tr>
</tbody>
</table>
## Appendix II

### Capacitor conversion table for pico-Farads, nano-Farads, and micro-Farads

<table>
<thead>
<tr>
<th>micro-Farads (µF)</th>
<th>Nano-Farads (nF)</th>
<th>Pico-Farads (pF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000001</td>
<td>0.001</td>
<td>1</td>
</tr>
<tr>
<td>0.00001</td>
<td>0.01</td>
<td>10</td>
</tr>
<tr>
<td>0.0001</td>
<td>0.1</td>
<td>100</td>
</tr>
<tr>
<td>0.001</td>
<td>1</td>
<td>1000</td>
</tr>
<tr>
<td>0.01</td>
<td>10</td>
<td>10000</td>
</tr>
<tr>
<td>0.1</td>
<td>100</td>
<td>100000</td>
</tr>
<tr>
<td>1</td>
<td>1000</td>
<td>1000000</td>
</tr>
<tr>
<td>10</td>
<td>10000</td>
<td>10000000</td>
</tr>
<tr>
<td>100</td>
<td>100000</td>
<td>100000000</td>
</tr>
</tbody>
</table>
LABORATORY REGULATIONS AND SAFETY RULES

The following regulations and safety rules must be observed in all laboratory locations.

1. It is the duty of all concerned who use any electrical laboratory to take all reasonable steps to safeguard the HEALTH and SAFETY of themselves and all other users and visitors.
2. Be sure that all equipment is properly working before using for laboratory exercises. Any defective equipment must be reported immediately to the lab instructors or lab technical staff.
3. Students are allowed to use only the equipment provided in the experiment manual or equipment used for senior project laboratory.
4. Power supply terminals connected to any circuit are only energized in the presence of the instructor or lab staff.
5. Students should keep a safe distance from the circuit breakers, electric circuits or any moving parts during the experiment.
6. Avoid any body contact between energized circuits and ground.
7. Switch off equipment and disconnect power supplies from the circuit before leaving the laboratory.
8. Observe cleanliness and proper laboratory housekeeping of the equipment and other related accessories.
9. Wear the proper clothes and safety gloves or goggles required in working areas involving fabrications of printed circuit boards, chemical process control systems, antenna communication equipment and laser facility laboratories.
10. Double check your circuit connections specifically in handling electrical power machines, AC motors and generators before switching “ON” the power supply.
11. Make sure that the last connection to be made in your circuit is the power supply and first thing to be disconnected is also the power supply.
12. Equipment should not be removed or transferred to any location without permission from the laboratory staff.
13. Software installation in any computer laboratory is not allowed without the permission from the laboratory staff.
14. Computer games are strictly prohibited in the computer laboratory.
15. Students are not allowed to use any equipment without proper orientation and actual hands-on equipment operation.
16. Smoking, eating and drinking in the laboratory are prohibited.

The above rules and regulations are necessary precautions in the electrical laboratory to safeguard the students, laboratory staff, the equipment and other laboratory users.